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Preface

The Service Registry 3.1 User's Guide describes how to use the Web Console utility provided
with Service Registry (“the Registry”). The Web Console allows users to search the Registry for
data and to publish data to the Registry. The User's Guide also provides troubleshooting
information.

Service Registry is an ebXML Registry: a federated registry and repository that manages all types
of electronic content described by standard and extensible metadata. It provides federated,
secure information management of Service Oriented Architecture (SOA) and other content and
metadata. It supports the ebXML Registry 3.0 and UDDI 3.0 registry protocols.

Who Should Use This Book
The User's Guide is intended for administrators and end users who search the Registry and
publish data to the Registry. This guide assumes you are familiar with the basic concepts of the
ebXML Registry and Repository specifications.

Before You Read This Book
You should be familiar with the basic concepts of these specifications:

■ ebXML Registry Information Model Version 3.0
■ ebXML Registry Services and Protocols Version 3.0

Service Registry is a component of Sun JavaTM Enterprise System (“Java ES”), a software
infrastructure that supports enterprise applications distributed across a network or Internet
environment. You should be familiar with the Java ES documentation at
http://docs.sun.com/coll/1286.2.

7
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How This Book Is Organized
The contents of this book are as follows:

Chapter 1 describes the main elements of the Web Console and describes the preliminary steps
to follow before you search the Registry and publish data to the Registry.

Chapter 2 describes how to search the registry.

Chapter 3 describes how to create objects and publish them to the Registry.

Chapter 4 describes solutions to some problems that you can encounter when using the Web
Console.

Service Registry Documentation Set
The Service Registry documentation set is available at http://docs.sun.com/coll/1314.2. To
learn about Service Registry, refer to the books listed in the following table.

TABLE P–1 Service Registry Documentation

Document Title Contents

Service Registry 3.1 Release Notes Contains the latest information about Service
Registry, including known problems.

Service Registry 3.1 Administration Guide Describes how to configure Service Registry after
installation and how to use the administration tool
provided with the Registry. It also describes how to
perform other administrative tasks.

Service Registry 3.1 User’s Guide Describes how to use the Service Registry Web
Console to search Service Registry and to publish data
to it.

Service Registry 3.1 Developer’s Guide Describes how to use the Java API for XML Registries
(JAXR) to search Service Registry and to publish data
to it.

Related Books
When you install Service Registry, it is deployed to Sun Java System Application Server. For
information about administering Application Server, refer to the Sun Java System Application
Server Enterprise Edition 8.2 Administration Guide.

Preface
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The Java ES documentation set describes deployment planning and system installation. The
URL for system documentation is http://docs.sun.com/coll/1286.2. For an introduction to
Java ES, refer to the books in the order in which they are listed in the following table.

TABLE P–2 Java Enterprise System Documentation

Document Title Contents

Sun Java Enterprise System 5 Release
Notes for UNIX

Sun Java Enterprise System 5 Release
Notes for Microsoft Windows

Contains the latest information about Java ES, including known
problems. In addition, components have their own release notes listed
in the Release Notes Collection
(http://docs.sun.com/coll/1315.2).

Sun Java Enterprise System 5
Technical Overview

Introduces the technical and conceptual foundations of Java ES.
Describes components, the architecture, processes, and features.

Sun Java Enterprise System
Deployment Planning Guide

Provides an introduction to planning and designing enterprise
deployment solutions based on Java ES. Presents basic concepts and
principles of deployment planning and design, discusses the solution
life cycle, and provides high-level examples and strategies to use when
planning solutions based on Java ES.

Sun Java Enterprise System 5
Installation Planning Guide

Helps you develop the implementation specifications for the hardware,
operating system, and network aspects of your Java ES deployment.
Describes issues such as component dependencies to address in your
installation and configuration plan.

Sun Java Enterprise System 5
Installation Guide for UNIX

Sun Java Enterprise System 5
Installation Guide for Microsoft
Windows

Guides you through the process of installing Java ES. Also shows how
to configure components after installation, and verify that they
function properly.

Sun Java Enterprise System 5
Installation Reference for UNIX

Gives additional information about configuration parameters,
provides worksheets to use in your configuration planning, and lists
reference material such as default directories and port numbers on the
Solaris Operating System and Linux operating environment.

Sun Java Enterprise System 5 Upgrade
Guide for UNIX

Sun Java Enterprise System 5 Upgrade
Guide for Microsoft Windows

Provides instructions for upgrading to Java ES 5 from previously
installed versions.

Sun Java Enterprise System 5
Monitoring Guide

Gives instructions for setting up the Monitoring Framework for each
product component and using the Monitoring Console to view
real-time data and create monitoring rules.

Sun Java Enterprise System Glossary Defines terms that are used in Java ES documentation.

Preface
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The URL for all documentation about Java ES and its components is
http://docs.sun.com/prod/entsys.5.

Default Paths and File Names
The following table describes the default paths and file names that are used in this book.

TABLE P–3 Default Paths and File Names

Placeholder Description Default Value

ServiceRegistry-base Represents the base installation
directory for Service Registry.

Solaris OS: /opt/SUNWsrvc-registry

Linux and HP-UX systems:
/opt/sun/srvc-registry

RegistryDomain-base Represents the directory where the
Application Server domain for
Service Registry is located and where
the Service Registry database is
located.

Solaris OS:
/var/opt/SUNWsrvc-registry

Linux and HP-UX systems:
/var/opt/sun/srvc-registry

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–4 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 A placeholder to be replaced with a real
name or value

The command to remove a file is rm filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized (note that some emphasized
items appear bold online)

Read Chapter 6 in the User's Guide.

A cache is a copy that is stored locally.

Do not save the file.

Preface
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Shell Prompts in Command Examples
The following table shows default system prompts and superuser prompts.

TABLE P–5 Shell Prompts

Shell Prompt

C shell on UNIX and Linux systems machine_name%

C shell superuser on UNIX and Linux systems machine_name#

Bourne shell and Korn shell on UNIX and Linux systems $

Bourne shell and Korn shell superuser on UNIX and Linux systems #

Microsoft Windows command line C:\

Symbol Conventions
The following table explains symbols that might be used in this book.

TABLE P–6 Symbol Conventions

Symbol Description Example Meaning

[ ] Contains optional arguments
and command options.

ls [-l] The -l option is not required.

{ | } Contains a set of choices for a
required command option.

-d {y|n} The -d option requires that you use
either the y argument or the n
argument.

${ } Indicates a variable
reference.

${com.sun.javaRoot} References the value of the
com.sun.javaRoot variable.

- Joins simultaneous multiple
keystrokes.

Control-A Press the Control key while you press
the A key.

+ Joins consecutive multiple
keystrokes.

Ctrl+A+N Press the Control key, release it, and
then press the subsequent keys.

→ Indicates menu item
selection in a graphical user
interface.

File → New → Templates From the File menu, choose New.
From the New submenu, choose
Templates.

Preface
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Documentation, Support, and Training
The Sun web site provides information about the following additional resources:

■ Documentation (http://www.sun.com/documentation/)
■ Support (http://www.sun.com/support/)
■ Training (http://www.sun.com/training/)

Searching Sun Product Documentation
Besides searching Sun product documentation from the docs.sun.comSM web site, you can use a
search engine by typing the following syntax in the search field:

search-term site:docs.sun.com

For example, to search for “broker,” type the following:

broker site:docs.sun.com

To include other Sun web sites in your search (for example, java.sun.com, www.sun.com, and
developers.sun.com), use sun.com in place of docs.sun.com in the search field.

Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related information.

Note – Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content, advertising,
products, or other materials that are available on or through such sites or resources. Sun will not
be responsible or liable for any actual or alleged damage or loss caused or alleged to be caused by
or in connection with use of or reliance on any such content, goods, or services that are available
on or through such sites or resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Send Comments.
In the online form, provide the full document title and part number. The part number is a
7-digit or 9-digit number that can be found on the book's title page or in the document's URL.
For example, the part number of this book is 819-4639.
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Getting Started with the Web Console

The Web Console is a web-based user interface that allows you to search the Registry and to
publish content to the Registry and Repository. This chapter describes the preliminary steps to
follow before you can perform these operations.

■ “Starting the Web Console” on page 13
■ “Changing the Default Language” on page 14
■ “Enabling Versioning of Registry Content” on page 16
■ “Creating a User Account” on page 16

Starting the Web Console
To start the Web Console, type the following URL into a browser:

http://hostname:port/soar/

Here is an example:

http://localhost:6480/soar/

If the Registry is installed on your system, the hostname is localhost. If the Registry is not
installed on your system, use the name of the system where the Registry is installed. The port
value is usually 6480 unless there is a port conflict.

The Web Console has the following main sections:

■ Top banner, where you can do the following:
■ Go to the Welcome page of the Web Console
■ Access the Registry documentation or online help
■ Log in and log out
■ Reset the locale (see “Changing the Default Language for Labels and Messages” on page

14
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■ End the current session
■ Set versioning for Registry content (see “Enabling Versioning of Registry Content”

on page 16)
■ Set the content language (see “Changing the Default Language for Registry Content”

on page 15)
■ Menu area on the left side of the screen, which contains three tabs:

■ Tasks
■ Search
■ Explore

■ Main area, which contains either the Welcome page or a page resulting from a task, search,
or explore action

When you first access the Web Console, you see the Welcome page, and the Tasks tab is visible.
Click the Home link in the banner area to return to this page and tab.

Click Documentation to view the Service Registry documentation at
http://docs.sun.com/coll/1314.2 in a new browser window.

Click User Guide to view the online help for the Web Console in a new browser window.

You use the Login button to log in to the Web Console, but you do not perform this task until
you have created a user account. After you log in, the Login button is grayed out, and the End
Session button changes to a Logout button.

Click the End Session button to exit the Web Console when you are not logged in.

If you click either End Session or Logout, you go to a Session Ended page that allows you to
return to the Registry and start a new session.

Changing the Default Language
You can change the default language for the display of two kinds of information:

■ Web Console labels and messages
■ Registry content

Changing the Default Language for Labels and
Messages
The Web Console’s labels and messages can be displayed in the languages listed in Table 1–1.

Changing the Default Language
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TABLE 1–1 Languages Supported by the Web Console

Language Code

Simplified Chinese (China) zh_CN

Traditional Chinese (Taiwan) zh_TW

English (United States) en

French fr

German de

Japanese ja

Korean ko

Spanish es

▼ To Change the Language for Labels and Messages

Add the language to your browser language preferences by following the instructions for the
browser.
For most browsers, you can find the language settings in the General area of the Internet
Options, Options, or Preferences dialog box.

Make the language your preferred language by placing it first in the list of languages.

Click the Reset Locale button.
The labels appear in the appropriate language.

Changing the Default Language for Registry Content
You can publish content to the registry in any of the languages that appear in the Content
Language drop-down list in the top banner area. The default is the language setting for your
browser.

To change the language from the default, choose the language from the Content Language
drop-down list.

1

2

3
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Enabling Versioning of Registry Content
By default, versioning of registry objects is turned off. All objects have the version number 1.1. If
you want an object to obtain a new version number when you modify it, select the Versioning
ON checkbox. Selection of this checkbox has no effect unless an administrator has performed
the task described in “Enabling Versioning of Registry Objects” in Service Registry 3.1
Administration Guide.

Creating a User Account
You can browse the public content of the Registry without logging in to the Registry. However,
to gain read access to private objects and write access to public objects, you must have a user
account with the Registry. After you create a user account, you can perform secure operations
such as publishing, modifying, and removing objects.

Creating a user account involves the following general steps:

1. Fill out a new user's details form.
2. Associate a set of credentials with the user account. You can obtain these credentials in

either of two ways:
■ The Registry can generate credentials for you. This is the simpler way to obtain

credentials.
■ If you have a certificate issued by a third-party certificate authority, you can use this

certificate to obtain credentials. Before you can use the certificate, an administrator must
install the third-party root certificates into the Application Server domain for the
Registry. See “To Add Root Certificates to the Trusted Certificates in the Registry
Domain” in Service Registry 3.1 Administration Guide for details.

To create a user account, perform the following tasks:
■ “To Start the User Registration Wizard” on page 16
■ Either “To Obtain a Registry-Generated Certificate” on page 17 or “To Use a Third-Party

Certificate” on page 18
■ Either “To Load the Certificate into the Mozilla or Firefox Browser” on page 19 or “To Load

the Certificate into the Internet Explorer Browser” on page 20
■ “To Log In to the Registry” on page 21
■ “Authenticating to the Registry” on page 21

▼ To Start the User Registration Wizard
Click the Tasks tab in the left menu area, then click Create User Account.

Click the Start Registration Wizard button.

1

2
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Read the instructions under Step 1: Requirements and click Next.

Fill out the New User's Details form.

You must enter data in the following fields:

■ First Name
■ Last Name
■ City
■ State or Province
■ Country (limited to two characters; use country code)

Click Next.

The User Authentication Details page appears.

On the User Authentication Details page, select one of the following radio buttons:

■ Select Generate Key Pair and Download PKCS12 KeyStore (the default) if you want the
Registry to create a certificate for you. See “To Obtain a Registry-Generated Certificate”
on page 17 for details about this task.

■ Select Upload X.509 Certificate (DER) if you want to use an existing third-party certificate.
See “To Use a Third-Party Certificate” on page 18 for details about this task.

▼ To Obtain a Registry-Generated Certificate
Follow these steps if you selected the Generate Key Pair and Download PKCS12 KeyStore radio
button on the User Authentication Details page.

On the User Authentication Details page, type a user name in the Alias text field.

Type a password in the Password and Password (repeat) text fields.

The password must be at least 6 characters in length.

Type values in the following text fields:

■ Organizational Unit
■ Organization

The Name field contains the name that you specified as the Last Name in the New User's Details
form. The City, State or Province, and Country fields also contain the values you specified in the
New User's Details form. These fields are not editable. If you need to make corrections in these
fields, click Previous and make the corrections in the New User's Details form.

All fields are required.

3

4

5

6
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Click Next.
A page labeled Step 4: Load Key to Web browser appears, with the message “New user
successfully registered.”

Click Download.

In the dialog box, choose the option that allows you to save the generated certificate to disk. In
the file chooser dialog, choose a directory and name for the file.
The file must have the suffix .p12.

The default action is to save the certificate in your home directory, in a file that is named
generated-key.p12.

Import the generated certificate into your browser.
See “To Load the Certificate into the Mozilla or Firefox Browser” on page 19 or “To Load the
Certificate into the Internet Explorer Browser” on page 20 for details.

▼ To Use a Third-Party Certificate
Follow these steps if you selected the Upload X.509 Certificate (DER) radio button on the User
Authentication Details page. These steps place the certificate in the server keystore for the
Registry and load the certificate into the browser.

The third-party certificate must be in X.509 format. Typically, the certificate is in a file with the
suffix .cer.

On the User Authentication Details page, click the Choose Certificate File button.

In the File Upload dialog box, click the Browse button to locate the file to upload, then click
Upload File.

Click OK.
The name of the file appears on the User Authentication Details page next to the Choose
Certificate File button.

Click Next.

On the Step 4: Load Key to Web browser page, follow the instructions to import the certificate
into your browser if it is not already there.
See “To Load the Certificate into the Mozilla or Firefox Browser” on page 19 or “To Load the
Certificate into the Internet Explorer Browser” on page 20 for details.
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▼ To Load the Certificate into the Mozilla or Firefox
Browser

Navigate to the certificate manager window. Depending on your version of Mozilla or Firefox,
the path to this window could be any of the following:

■ Edit→Preferences→Privacy & Security→Certificates→Manage Certificates
■ Edit→Preferences→Advanced→Security→View Certificates
■ Tools→Options→Advanced→Certificates→Manage Certificates
■ Tools→Options→Advanced→Encryption→View Certificates

The certificate manager window appears, open to the Your Certificates tab.

In Mozilla or more recent versions of Firefox, click the Manage Certificates button. In some
earlier versions of Firefox, click View Certificates.

Click the Import button.

In the File Name to Restore file chooser dialog, select the .p12 certificate file, then click Open.

In the Prompt dialog, type an account password for the Master Password for the Software
Security Device.

This password is specific to your browser account and is assigned by the browser profile owner.
A common convention is to use the same password as the login account on the client machine.

In the Password Entry dialog, type the certificate password.

This password is used to protect the client certificate. If you are using a registry-generated
certificate, type the password that you specified on the User Authentication Details page.

An Alert dialog with the message: “Successfully restored your security certificate(s) and private
key(s)” appears.

Click OK.

Close the Certificate Manager and Preferences/Options dialogs.

After you import the certificate, you are ready to log in to the registry. See “To Log In to the
Registry” on page 21 for details.
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▼ To Load the Certificate into the Internet Explorer
Browser

Choose Internet Options from the Tools menu.

Click the Content tab.

Click Certificates.

Click Import to open the Certificate Import Wizard.

In the Certificate Import Wizard, click Next.

On the File to Import page, click Browse and locate the .p12file, then click Next.

On the Password page, do the following:

a. Type the password that you specified for the certificate.

b. Select the Mark the Key as Exportable checkbox.

c. Do not select the Enable Strong Private Key Protection checkbox.

d. Click Next.

On the Certificate Store page, choose the default, Place All Certificates in the Following Store
(Personal), then click Next.

Click Finish.

Click OK in the information dialog that appears.

The new certificate, with the first and last name you specified, appears in the Certificates
window.

Click Close in the Certificates window.

Click OK in the Internet Options window.

After you import the certificate, you are ready to log in to the registry. See “To Log In to the
Registry” on page 21 for details.
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▼ To Log In to the Registry
After you import a certificate to the browser, you are ready to log in.

On the Step 4: Load Key to Web browser page, click the Finish button.

In the top banner area of the Web Console, click the Login button.

Click OK in the dialog boxes to verify the certificate.
After you log in, an “Authentication successful.” message appears in the top banner area. In
addition, the first and last names you entered appear after the Current User label in the top
banner area of the Web Console, in Lastname, Firstname format.

Authenticating to the Registry
After you log in to the Registry, authentication happens transparently whenever you try to add,
delete, or modify a Registry object, because any write request triggers authentication based on
the client certificate loaded into your browser.

After authentication is completed, access to the Registry is over https.

When your session expires, you are no longer authenticated by the Registry. A subsequent write
request prompts the Web Console to re-authenticate you.

Note – If authentication fails, stop and restart your browser and try again. If you accidentally
choose the wrong certificate and have difficulty logging in, see “Login Error from Mistake in
Client Certificate Selection” on page 65 for information on what to do.
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Searching the Registry

The Search and Explore tabs in the menu area allow you to search the Registry.

■ “Using the Search Tab” on page 23
■ “Selecting a Query” on page 24
■ “Searching by Object Type” on page 25
■ “Searching by Name and Description” on page 27
■ “Searching by Status” on page 27
■ “Searching by Classification” on page 28
■ “Performing WSDL Queries” on page 30
■ “Viewing Search Results” on page 34
■ “Viewing Object Details” on page 36
■ “Using the Explore Tab” on page 39

Using the Search Tab
Click the Search tab. The Search form opens. The form contains a Select Predefined Query
combo box. It also contains a description of the selected query and three buttons:

■ Search, which performs the query
■ Clear, which clears the form and the Registry Objects area
■ Help, which provides help on searching the Registry

The remaining contents of the form depend on which query you select. The default query is
Basic Query.

■ Select Predefined Query combo box
■ Name text field
■ Description text field
■ ClassificationSchemes tree

The next few sections describe how to use these components.

2C H A P T E R 2
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Selecting a Query
The Select Predefined Query combo box contains the items shown in Table 2–1.

TABLE 2–1 Predefined Queries

Query Name Search Purpose

Basic Query The default generic query, which allows you to search by object
type, name, description, and classification

Basic Query - Case Sensitive Case-sensitive version of Basic Query

FindAllMyObjects Finds all objects owned (published) by the user who makes the
query. May take a long time if the user owns many objects

GetCallersUser Finds the User object for the user who makes the query

WSDL Discovery Query Finds Web Services Description Language (WSDL) documents

WSDL Binding Discovery Query Finds abstract service interfaces protocol bindings described as
WSDL Binding definitions

WSDL Port Discovery Query Finds implementations of service interfaces described as WSDL
Port definitions

WSDL PortType Discovery Query Finds abstract service interfaces described as WSDL PortType
definitions

WSDL Service Discovery Query Finds web services described as WSDL Service definitions

The default selection is Basic Query. The search form for Basic Query and Basic Query — Case
Sensitive contains the following components:

■ Object Type combo box
■ Name text field
■ Description text field
■ Status combo box
■ Select Classification Node button

You can specify any or all of these criteria in a single search. The following sections describe
how to perform basic queries:

■ “Searching by Object Type” on page 25
■ “Searching by Name and Description” on page 27
■ “Searching by Status” on page 27
■ “Searching by Classification” on page 28

Use the FindAllMyObjects query to search for all the objects that you have published. The query
results list all the objects you own except for AuditableEvent objects, which should not be
edited or deleted.

Selecting a Query
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Use the GetCallersUser query to view or modify data for the user you created when you
registered.

See “Performing WSDL Queries” on page 30 for information on using the WSDL queries.

Searching by Object Type
The simplest search is by object type only.

The default choice in the Object Type combo box is RegistryObject, which finds all objects in
the Registry. To narrow the search, change the object type.

The ClassificationNode choice lists concepts within classification schemes.
ClassificationNode is a synonym for Concept.

Table 2–2 describes the object types available in the Registry.

TABLE 2–2 Service Registry Object Types

Object Type Description

AdhocQuery Represents an ad hoc query expressed in a query syntax. AdhocQuery objects
are used for discovery of registry objects. AdhocQuery objects are similar in
purpose to the concept of stored procedures in relational databases. For
example, the predefined queries in the Search panel are all AdhocQuery
objects.

Association Defines a relationship between two objects.

AuditableEvent Provides a record of a change to an object. A collection of AuditableEvent
objects constitutes an object's audit trail.

Classification Classifies an object by using a ClassificationScheme.

ClassificationNode Represents a taxonomy element that has a structural relationship with other
elements in an internal ClassificationScheme. Also called a Concept.

ClassificationScheme Represents a taxonomy used to classify objects. In an internal
ClassificationScheme, all taxonomy elements are defined in the registry as
Concept instances. In an external ClassificationScheme, the values are not
defined in the registry as Concept instances but instead are referenced by
their String representations.

ExternalIdentifier Provides additional information about an object by using String values
within an identification scheme (an external ClassificationScheme).
Examples of identification schemes are DUNS numbers and Social Security
numbers.

ExternalLink Provides a URI for content that resides outside the registry.

Searching by Object Type
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TABLE 2–2 Service Registry Object Types (Continued)
Object Type Description

ExtrinsicObject Provides metadata that describes submitted content whose type is not
intrinsically known to the registry and that therefore must be described by
means of additional attributes, such as MIME type.

Federation Represents an affiliated group of registries.

Notification Represents a notification from the registry regarding an event that matches a
Subscription.

Organization Provides information about an organization. May have a parent, and may
have one or more child organizations. Always has a User object as a primary
contact, and may offer Service objects.

Person, User Provides information about persons and registered users within the registry.
User objects are affiliated with Organization objects.

Registry Represents a registry.

RegistryPackage Represents a logical grouping of any number of registry objects.

Service Provides information on a service. May contain one or more
ServiceBinding objects.

ServiceBinding Represents technical information on how to access a service.

SpecificationLink Provides the linkage between a ServiceBinding and a technical specification
that describes how to use the service by using the ServiceBinding.

Subscription Defines a User's interest in certain types of AuditableEvent. A User creates a
Subscription in order to receive notification of certain types of events.

▼ To Search by Object Type
Choose an object type from the Object Type combo box.

Click the Search button, or place the cursor in the Name or Description text field and press
Return.
The search returns all objects of the specified type. You can narrow the search by specifying a
name, description, status, or classification.
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Searching by Name and Description
You can search for objects by name, by description, or by both.

▼ To Search by Name or Description
Type a string in the Name or Description field.
By default, the search looks for a name or description that matches the entire string that you
typed. You can use wildcards to find a range of objects.

The wildcard characters are percent (%) and underscore (_).
The percent wildcard matches multiple characters:

■ Type %off% to return names or descriptions that contain the string off, such as Coffee.
■ Type nor% to return names or descriptions that start with Nor or nor, such as North and

northern.
■ Type %ica to return names or descriptions that end with ica, such as America.

The underscore wildcard matches a single character. For example, the search string _us_ would
match objects named Aus1 and Bus3.

Click the Search button or press Return.

Searching by Status
An object in the Registry can have one of four statuses:

■ Approved
■ Deprecated
■ Submitted
■ Withdrawn

The default status of an object in the Registry is Submitted. An object can be approved or
deprecated by a Registry administrator or by the owner of the object. An ExtrinsicObject has
the status Withdrawn if its repository item has been removed.

▼ To Search by Status
Choose a status from the Status combo box.
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Click the Search button, or place the cursor in the Name or Description text field and press
Return.

The search returns all objects that have the specified status. You can narrow the search by
specifying an object type, name, description, or classification.

Searching by Classification
Classification objects classify or categorize objects in the registry by using unique concepts
(ClassificationNode objects) that define valid values within a classification scheme. The
classification scheme is the parent in a tree hierarchy that contains generations of child
concepts. Table 2–3 describes the classification schemes provided by the Registry specifications,
which are called canonical classification schemes. Many of the terms in this table are defined in
the Registry specifications.

TABLE 2–3 Canonical Classification Schemes

Classification Scheme Name Usage Description or Purpose

AssociationType Frequently Defines the types of associations between
registry objects. Used as the value of the
associationType attribute of an
Association instance to describe the
nature of the association.

ContentManagementService Rarely Defines the types of content management
services. Used in the configuration of a
content management service, such as a
validation or cataloging service.

DataType Frequently Defines the data types for object attributes.
Used as the value of the slotType attribute
of a Slot instance to describe the data type
of the Slot value.

DeletionScopeType Occasionally Defines the values for the deletionScope
attribute of the RemoveObjectsRequest
protocol message.

EmailType Rarely Defines the types of email addresses.

ErrorHandlingModel Rarely Defines the types of error handling models
for content management services.

ErrorSeverityType Rarely Defines the different error severity types
encountered by the Registry while
processing protocol messages.
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TABLE 2–3 Canonical Classification Schemes (Continued)
Classification Scheme Name Usage Description or Purpose

EventType Occasionally Defines the types of events that can occur
in a registry.

InvocationModel Rarely Defines the different ways that a content
management service can be invoked by the
Registry.

NodeType Occasionally Defines the different ways in which a
ClassificationScheme can assign the
value of the code attribute for its
ClassificationNode (Concept) objects.

NotificationOptionType Rarely Defines the different ways in which a client
can be notified by the registry of an event
within a Subscription.

ObjectType Occasionally Defines the different types of
RegistryObject a registry may support.

PhoneType Rarely Defines the types of telephone numbers.

QueryLanguage Rarely Defines the query languages supported by
the Registry.

ResponseStatusType Rarely Defines the different types of status for a
RegistryResponse.

StatusType Occasionally Defines the different types of status for a
RegistryObject.

SubjectGroup Rarely Defines the groups that a user can belong
to for access control purposes.

SubjectRole Rarely Defines the roles that can be assigned to a
user for access control purposes.

The primary purpose of the canonical classification schemes is not to classify objects but to
provide enumerated types for object attributes. The Registry also contains a number of
non-canonical classification schemes, and you can create your own.

▼ To Search by Classification
Click the Select Classification Node button.

The Classification Node Selector window appears.
1
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Click the folder icon for the classification scheme you want to use.
The number in parentheses after each entry indicates how many concepts (ClassificationNode
objects) the parent contains.

Expand concept nodes beneath the classification scheme until you find the leaf node by which
you want to search. A leaf node is a node with no concepts beneath it.

Select the leaf node.

Click Close in the Classification Node Selector window.
The ID of the concept you chose appears in a Value text field.

Click the Search button, or place the cursor in the Name or Description text field and press
Return.

Performing WSDL Queries
The Search panel contains predefined queries that allow you to search for WSDL files using
different search criteria:

■ WSDL Discovery Query
■ WSDL Binding Discovery Query
■ WSDL Port Discovery Query
■ WSDL PortType Discovery Query
■ WSDL Service Discovery Query

This section describes how to perform these searches. For all the searches, you can specify as
many or as few of the search criteria as you wish.

▼ To Perform a WSDL Discovery Query
Choose WSDL Discovery Query from the Select Predefined Query combo box.
A search form appears.

Type values in the Name and/or Description fields.

Select a value from the Status combo box.

Type a value in the Target Namespace field.

Click Search or press Return.
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▼ To Perform A WSDL Binding Discovery Query
Choose WSDL Binding Discovery Query from the Select Predefined Query combo box.

A search form appears.

Type values in the Binding Name and/or Binding Description fields.

Select a value from the Binding Status combo box.

Type a value in the Binding Target Namespace field.

Select a value from the Binding Protocol Type combo box.

Select a value from the Binding Transport Type combo box.

Select a value from the SOAP Binding Style combo box.

Optionally, select the Consider PortType checkbox. If you If you select this checkbox:

a. Type values in the PortType Name and/or PortType Description fields.

b. Select a value from the PortType Status combo box.

c. Type a value in the PortType Target Namespace field.

Click Search or press Return.

▼ To Perform a WSDL Port Discovery Query
Choose WSDL Port Discovery Query from the Select Predefined Query combo box.

A search form appears.

Type values in the Port Name and/or Port Description fields.

Select a value from the Port Status combo box.

Type a value in the Port Target Namespace field.

Type a value in the Port Endpoint field.
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Optionally, select the Consider Binding checkbox. If you select this checkbox:

a. Type values in the Binding Name and/or Binding Description fields.

b. Select a value from the Binding Status combo box.

c. Type a value in the Binding Target Namespace field.

d. Select a value from the Binding Protocol Type combo box.

e. Select a value from the Binding Transport Type combo box.

f. Select a value from the SOAP Binding Style combo box.

g. Optionally, select the Consider PortType checkbox. If you select this checkbox:

i. Type values in the PortType Name and/or PortType Description fields.

ii. Select a value from the PortType Status combo box.

iii. Type a value in the PortType Target Namespace field.

Click Search or press Return.

▼ To Perform a WSDL PortType Discovery Query
Choose WSDL PortType Discovery Query from the Select Predefined Query combo box.

A search form appears.

Type values in the PortType Name and/or PortType Description fields.

Select a value from the PortType Status combo box.

Type a value in the PortType Target Namespace field.

Click Search or press Return.
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▼ To Perform a WSDL Service Discovery Query
Choose WSDL Service Discovery Query from the Select Predefined Query combo box.

A search form appears.

Type values in the Service Name and/or Service Description fields.

Select a value from the Service Status combo box.

Type a value in the Service Target Namespace field.

Optionally, select the Consider Port checkbox. If you check this box:

a. Type values in the Port Name and/or Port Description fields.

b. Select a value from the Port Status combo box.

c. Type a value in the Port Target Namespace field.

d. Type a value in the Port Endpoint field.

e. Optionally, select the Consider Binding checkbox. If you select this checkbox:

i. Type values in the Binding Name and/or Binding Description fields.

ii. Select a value from the Binding Status combo box.

iii. Type a value in the Binding Target Namespace field.

iv. Select a value from the Binding Protocol Type combo box.

v. Select a value from the Binding Transport Type combo box.

vi. Select a value from the SOAP Binding Style combo box.

vii. Optionally, select the Consider PortType checkbox. If you select this checkbox:

Type values in the PortType Name and/or PortType Description fields.

Select a value from the PortType Status combo box.

Type a value in the PortType Target Namespace field.
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Click Search or press Return.

See “To Find the WSDL Document for a Service” on page 34 for information on locating the
WSDL file associated with the service you found.

▼ To Find the WSDL Document for a Service
After you find a service, you ordinarily want to find the WSDL file associated with the service so
that you can use it to create a client proxy to communicate with the service. To do so, follow
these steps.

Click the Details link for the Service object.

Click the Associations tab.
The Source Object column contains a link named WSDL.

Click the WSDL link.
A Details window appears.

Click View Repository Item Content to view the WSDL file.

Use your browser's Save As menu item to save the file to your local system.

Viewing Search Results
Objects found by a search appear in the Registry Objects area.

The Registry Objects area consists of the following:

■ Buttons that are labeled Apply, Approve, Deprecate, Undeprecate, Bookmark, Relate,
Delete, and Set or Change Status, which allow you to perform actions on objects. You must
be the object’s creator or a registry administrator to perform any of these actions except for
Bookmark.

■ A found objects display consisting of a search results table. For most objects, the table
contains the following columns:
■ Pick checkbox. Select any two objects to activate the Relate button. See “Creating

Relationships Between Objects” on page 61 for details. Select one or more objects and
click another button to perform that action. An error message appears if you do not have
permission to perform the action.

■ Details link. Click this link to open the Details area directly below the Registry Objects
area (see “Viewing Object Details” on page 36).
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■ Object Type field.
■ Name field.
■ Description field.
■ Version field.
■ Version Comment field.
■ Status field.

For ExtrinsicObject objects, the display has two additional columns: Content Version and
Content Version Comment. These columns apply to the repository item for the
ExtrinsicObject.

For two kinds of objects, the Version and Version Comment columns are replaced by other
content:

■ ExternalLink objects: External URI
■ ServiceBinding objects: Endpoint

▼ To Use the Bookmark Feature
The Bookmark feature of the user interface allows you to hold one or more objects in the
Registry Objects area while you search for other objects. You can then create a relationship
between two objects. See “Creating Relationships Between Objects” on page 61 for details on
how to perform this task.

Click Search and execute a query.

In the Registry Objects area, select the Pick checkbox for the object or objects that you want to
hold there and click the Bookmark button.
The objects appear in a Bookmarked Objects area above the search results.

Execute another query.

When you have finished using a bookmarked object, select the Pick checkbox for the object and
click the Remove Bookmark button. The object is removed from the Bookmarked Objects area.
If it was the only object in the Bookmarked Objects area, the Bookmarked Objects area
disappears.
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Viewing Object Details
In the search results table, click the Details link for an object to open the Details area
immediately below the Registry Objects area.

This section has a row of buttons and a row of tabs:

■ The buttons are Apply, Save, Cancel, Approve, Deprecate, Undeprecate, Delete, and Set or
Change Status. The buttons represent actions that you can perform on the object.

■ The tabs represent the object’s attributes. The tabs vary depending on the object type.Table
2–4 describes the tabs and the objects they apply to.

TABLE 2–4 Attribute Tabs in the Details Area

Tab Name Applies To

Object-Type Detail All objects (Object-Type is the object type name)

Slots All objects

Classifications All objects

External Identifiers All objects

Associations All objects

External Links All objects

Audit Trail All objects

Postal Addresses Organization, User

Telephone Numbers Organization, User

Email Addresses Organization, User

Users Organization

Organizations Organization

Service Bindings Service

Specification Links ServiceBinding

Concepts ClassificationScheme, ClassificationNode

Members RegistryPackage

Affected Objects AuditableEvent

Click a tab to find out if the object has any values for the attribute. If it does, click the Details link
for the attribute value to open a browser window with the details for the attribute value.

Viewing Object Details
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The Associations tab produces a table with three links for each Association:

■ Details
■ Source Object (the object type is shown)
■ Target Object (the object type is shown)

In the Source Object and Target Object columns, the type of the object whose associations you
are viewing is shown in bold.

The Audit Trail tab does not produce a table with a Details link. Instead, this tab produces a
table that contains the following information:

■ The event type
■ The date and time of the event
■ The name of the User that caused the event

For most objects, the Details area fields are as follows:

■ Unique Identifier. For every object, the Unique Identifier is an active link. Click this link to
view the XML for the object in a browser window. All registry objects are stored in XML
format.

■ Logical Unique Identifier. The Logical Unique Identifier is usually the same as the Unique
Identifier. If versioning is turned on, the Logical Unique Identifier remains the same for all
versions of the object, while the Unique Identifier for the new version receives a suffix that
indicates the version number.

■ Name
■ Description
■ Status (usually Submitted, meaning that the object has been published to the Registry)
■ Version
■ Version Comment

For many objects, the fields are largely self-explanatory (the postal addresses for an
Organization, for example). For some objects, the fields require some explanation. The
following sections describe these fields.

■ “Viewing Association Details” on page 38
■ “Viewing Classification Scheme Details” on page 38
■ “Viewing Extrinsic Object Details” on page 38
■ “Viewing External Link Details” on page 39

Viewing Object Details
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Viewing AssociationDetails
The Details area for an Association object contains the following additional fields:
■ Source Object and Target Object. For the source and target objects of the association, the

panel shows both the name and the object type. The Confirmed By Source Owner checkbox
indicates whether or not the association was confirmed or approved by the source object
owner. The Confirmed By Target Owner checkbox indicates whether or not the association
was confirmed or approved by the target object owner. These checkboxes are always selected
for intramural associations.

■ Association Type. The combo box displays the selected type of the Association.
■ Is Extramural. This checkbox is selected if at least one of the two associated objects is owned

by a User other than the User who created the Association. Otherwise, the Association is
defined as intramural.

Viewing Classification Scheme Details
The Details area for a ClassificationScheme object contains the following additional fields:
■ External Classification Scheme checkbox. This checkbox is selected if the classification

scheme is defined outside the Registry (that is, if it has no concepts). An internal
classification scheme is a classification scheme whose concept hierarchy is defined within
the Registry.

■ The Value Type combo box, which contains one of the following selections:
■ Unique. This value indicates that each node of the taxonomy has a unique code assigned

to it. This value is the default when you create a classification scheme in Service Registry.
■ Embedded Path. This value indicates that the unique code assigned to each node of the

taxonomy also encodes its path.
■ Non-Unique. In some cases nodes are not unique, and it is necessary to use the full path

(from the ClassificationScheme to the node of interest) to identify the node. For
example, in a geography taxonomy, Moscow could be under both Russia and the USA,
where five states have cities that are named Moscow.

Viewing Extrinsic Object Details
The Details area for an ExtrinsicObject object contains the following additional fields:
■ Content Version and Content Version Comment. The Details area shows the version and

optional comment for the repository item associated with the extrinsic object.
■ MimeType. This field contains the MIME type of the extrinsic object.
■ Is Opaque? checkbox. This checkbox is selected if the repository item content is not readable

by the Registry (for example, if it is encrypted).
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■ Object Type. This field contains the subconcept within the ObjectType/ExtrinsicObject tree.
■ View Content. Click the View Repository Item Content link to view the repository item in a

browser window.

Viewing External Link Details
The Details area for an ExternalLink object contains the following additional fields:

■ Object Type. This field contains either the ExternalLink object type or a subconcept within
the ObjectType/ExtrinsicObject tree.

■ Select Concept for Object Type button. Click this button to choose a subconcept within the
ObjectType/ExtrinsicObject tree that represents the content of the external URI.

■ A Display Content link under the External URI field. Click this link to view the contents of
the URI in a browser window.

Using the Explore Tab
The Explore tab allows you to navigate through Registry and Repository content by using the
metaphor of a hierarchy of file folders. The root folder, which is named registry, contains all
Registry content.

▼ To Use the Explore Tab
Click the Explore link.

Click the folder labeled registry. This folder contains two subfolders: userData, where all user
content is placed, and ClassificationSchemes.

Click a link to view the registry objects of that type. Click a folder or expand a node to view the
object types at the next level.

▼ To Explore the Classification Schemes
Click the ClassificationSchemes folder to open the ClassificationSchemes tree hierarchy in the
menu area.

Click any link to view that classification scheme in the Registry Objects area.
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Click a classification scheme folder to see the Concepts beneath it.
If the Concept icons are folders, they have subconcepts, and you can click the icons to expand
them. If the Concept icons are files, they have no subconcepts.

If the classification scheme folder is a file icon, the classification scheme does not have concepts
that are viewable in the Explore area.

Click a Concept link to view that concept in the Registry Objects area.

▼ To Explore the UserData Folder
Expand the userDatanode.

Expand the RegistryObject node. Do not click the link unless you want to view all registry
objects.

Click a folder to view the registry objects of that type. Expand a node to view the object types at
the next level.
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Publishing and Managing Registry Objects

The Create a New Registry Object menu item allows you to create objects and to publish the
objects to the Registry. This chapter describes the following tasks:

■ “Publishing Objects” on page 41
■ “Adding a Classification to an Object” on page 50
■ “Adding an External Identifier to an Object” on page 51
■ “Adding an External Link to an Object” on page 52
■ “Adding Custom Information to an Object Using Slots” on page 52
■ “Adding a Postal Address to an Organization or User” on page 53
■ “Adding a Telephone Number to an Organization or User” on page 54
■ “Adding an Email Address to an Organization or User” on page 55
■ “Adding a User to an Organization” on page 55
■ “Adding a Child Organization to an Organization” on page 56
■ “Adding a Service Binding to a Service” on page 56
■ “Adding a Specification Link to a Service Binding” on page 57
■ “Adding a Child Concept to a Classification Scheme or Concept” on page 58
■ “Adding Objects to a Registry Package” on page 58
■ “Changing the Status of Objects” on page 59
■ “Removing Objects” on page 60
■ “Creating Relationships Between Objects” on page 61

Publishing Objects
Publishing objects to the registry is a three-step process:

1. Create the object.
2. Add details and other objects, saving them to memory but not publishing them to the

Registry.
3. Publish the object to the Registry.
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You can publish objects to the registry if you have created a user account and have logged in. To
create a user account, follow the instructions in “Creating a User Account” on page 16.

The first task below describes the steps that you follow to create any new object. The sections
that follow describe the additional steps required to publish particular kinds of objects.

You can create and publish any of the objects listed in Table 2–2, with the following exceptions:

■ Association. See “Creating Relationships Between Objects” on page 61 for details on
creating Association objects.

■ Classification. You always create a classification as a composed object. See “Adding a
Classification to an Object” on page 50 for details.

■ Notification. A notification is created by the registry when a certain event occurs, as
specified by a Subscription object.

■ ServiceBinding. You always create a ServiceBinding as a composed object within a
Service. See “Adding a Service Binding to a Service” on page 56 for details.

■ SpecificationLink. You always create a SpecificationLink as a composed object within
a ServiceBinding. See “Adding a Specification Link to a Service Binding” on page 57 for
details.

■ Subscription. Creating a subscription is currently an administrative task.

This section describes the following tasks:

■ “To Create and Publish a New Registry Object” on page 42
■ “To Create and Publish an AdhocQuery Object” on page 43
■ “To Create and Publish a ClassificationNode Object” on page 44
■ “To Create and Publish a ClassificationScheme Object” on page 44
■ “To Create and Publish an ExternalLink Object” on page 45
■ “To Create and Publish an ExtrinsicObject Object” on page 45
■ “To Create and Publish a Federation Object” on page 47
■ “To Create and Publish an Organization Object” on page 48
■ “To Create and Publish a Person or User Object” on page 48
■ “To Create and Publish a Registry Object” on page 49
■ “To Create and Publish a RegistryPackage Object” on page 49
■ “To Create and Publish a Service Object” on page 50

▼ To Create and Publish a New Registry Object
In the Tasks tab of the left menu area, click Create a New Registry Object.

In the Registry Objects area, choose an object type from the combo box and click Add.
A Details form for the object appears in the Details area.
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Type a name in the Name field.

(Optional) Type a description in the Description field

(Optional) Type a comment in the Version Comment field.

(Optional) Replace the assigned Unique Identifier and Logical Unique Identifier with identifiers
of your own choosing.

Each identifier must be a valid URN and must be unique within your Registry installation.

Enter data in the fields specific to the object type.

Click Save to save the object in memory.

Note – Make sure that you save the changes you make in any of the tab areas for the object before
you move to another tab. If you do not save your work, it will be lost.

(Optional) Use the tabs in the Details form to add and save composed objects.

Click Apply to publish the object to the Registry.

A status message appears, indicating whether the apply was successful.

Either before or after you publish the object, you can edit the object by adding composed objects
to it. Table 2–4 lists the objects that you can add. Later sections describe how to add these
objects.

▼ To Create and Publish an AdhocQueryObject
An AdhocQuery object represents an ad hoc query expressed in a query syntax. AdhocQuery
objects are used for discovery of registry objects. AdhocQuery objects are similar in purpose to
the concept of stored procedures in relational databases. For example, the predefined queries in
the Search panel are all AdhocQuery objects.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
AdhocQuery.

(Optional) Select a query type from the Query Type combo box.

The default is SQL Query. Other supported query types are XQuery and ebXML Filter Query.
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Type the text of the query in the Query String field.
For a SQL query, use pairs of single quotes to enclose items that you normally enclose in single
quotes. These items are typically parameter placeholders and literals, when they occur in
subqueries. For example, specify a parameter placeholder in a subquery as follows:
(SELECT id FROM ClassificationNode WHERE path LIKE ’’$objectTypePath’’)

Specify both a literal and a parameter placeholder as follows:

... AND (ro.id = s.parent AND s.name_ =

’’urn:oasis:names:tc:ebxml-regrep:profile:ws:wsdl:nameSpacesUsed’’

AND s.value LIKE ’’$nameSpacePattern’’)

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

▼ To Create and Publish a ClassificationNodeObject
A ClassificationNode object represents a taxonomy element that has a structural relationship
with other elements in an internal classification scheme. You can create a ClassificationNode
object and then add it to a classification scheme, but it may be simpler to use the Concepts tab of
the ClassificationScheme Details panel to create concepts.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
ClassificationNode.

Type a value for the ClassificationNode object in the Value field.
The Classification Scheme, Parent Id, and Path fields are grayed out.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

▼ To Create and Publish a ClassificationSchemeObject
A ClassificationScheme object represents a taxonomy used to classify objects. In an internal
ClassificationScheme, all taxonomy elements are defined in the registry as Concept
instances. In an external ClassificationScheme, the values are not defined in the registry as
Concept instances but instead are referenced by their String representations.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
ClassificationScheme.
The External Classification Scheme checkbox is selected, to indicate that the scheme has no
concepts. If you add concepts to the classification scheme, the checkbox will no longer be
selected.

Select a value from the Value Type combo box:
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■ Unique. Indicates that each node of the taxonomy has a unique code assigned to it.
■ Embedded Path. Indicates that the unique code assigned to each node of the taxonomy also

encodes its path.
■ Non-Unique. Indicates that nodes are not unique and that it is necessary to use the full path

(from the ClassificationScheme to the node of interest) to identify the node.

The default is Unique.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

▼ To Create and Publish an ExternalLinkObject
An ExternalLink object provides a URI for content that resides outside the registry.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
ExternalLink.
The Object Type field contains the value ExternalLink.

(Optional) Click the Select Concept for Object Type button to select an object type for the data
referenced by the URI.
In the Extrinsic Object Classification Node Selector window, expand the nodes until you reach
the appropriate concept within the ExtrinsicObject type. After you click OK, the Object Type
window contains the type you selected.

Type the URI for the external link in the External URI field.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

Note – If you get an error when you try to save an ExternalLink object, it means that an
administrative task needs to be performed. See “Unable to Create ExternalLink or
ServiceBinding” on page 64 for details.

▼ To Create and Publish an ExtrinsicObjectObject
An ExtrinsicObject provides metadata that describes content whose type is not intrinsically
known to the registry and that therefore must be described by means of additional attributes,
such as MIME type.

Use an ExtrinsicObject to publish files of various kinds. Most commonly, these are Web
Services artifacts such as WSDL files.
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The ebXML Registry Profile for Web Services is an OASIS standard that defines the ebXML
Registry profile for publication, management, governance, discovery, and reuse of Web Services
artifacts. By default, Service Registry implements this profile. In practice, this means that when
you publish a WSDL file to the Registry as an ExtrinsicObject object, the Registry creates
some standard metadata for the document, in effect creating the web service defined by the
document. This feature is called WSDL cataloging.

To publish one or more WSDL files that have dependencies on each other or on other files (such
as XSD files), create a zip file that contains all the files.

It is possible for an administrator to disable the WSDL cataloging feature. See “Disabling the
WSDL Cataloger” in Service Registry 3.1 Administration Guide for details.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
ExtrinsicObject or one of its subtypes.
For example, to publish one or more WSDL files, select WSDL.

(Optional) Type the MIME type of the object in the MimeType field. The type should be one of
those listed in http://www.iana.org/assignments/media-types.
If you are uploading a stand-alone WSDL file (a text file containing XML), set the MIME type to
text/xml.

If you are uploading a zip file containing multiple WSDL (and, optionally, XSD) files, set the
MIME type to application/zip.

(Optional) Select the Is Opaque checkbox if the content of the object is not readable by the
registry (for example, if it is encrypted).

Click the Select Content for Object Type button if you need to select an object type more specific
than ExtrinsicObject.
In the Extrinsic Object Classification Node Selector window, expand the nodes until you reach
the appropriate concept within the ExtrinsicObject type. After you click OK, the Object Type
window contains the type you selected.

Click the Choose Repository Item File button to locate the repository item for the
ExtrinsicObject.

a. In the File Upload window, type the file path in the text field or click Browse.

b. If you clicked Browse, use the file chooser window to navigate to the file, then click Open.

c. In the File Upload window, click Upload File.

d. Click OK.
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The following additional items appear in the Details panel:

■ A Content Version field (grayed out)
■ A Content Version Comment field, which you can fill in
■ A Remove Repository Item button
■ A View Repository Item Content link

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

After you create an ExtrinsicObject object that refers to a WSDL file, you can find it by using
the WSDL Discovery Query. Also, if you use Basic Query to search for ExtrinsicObject
objects of type WSDL, for Service objects, and for ServiceBinding objects, you will find that
the Registry has created all the objects specified by the elements of the WSDL file:
■ For a service element, it creates a Service object. For the port subelement of the service

element, it creates a ServiceBinding object.
■ For a portType element, it creates a PortType object (a subtype of a WSDL

ExtrinsicObject).
■ For a binding element, it creates a Binding object (a subtype of a WSDL ExtrinsicObject).

▼ To Create and Publish a FederationObject
A Federation represents an affiliated group of registries. Its only attributes are the basic
RegistryObject attributes. You must be an administrator in order to create a Federation
object.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
Federation.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

Add affiliated registries to the federation by following the steps in “Creating Relationships
Between Objects”on page 61. The specific steps are as follows:

a. Search for the federation, select its Pick checkbox, and click Bookmark.

b. Search for the registry, select its Pick checkbox, and click Relate.

c. In the Create Relationship area, select the federation as the source object. The registry
becomes the target object.

d. Set the AssociationType to HasFederationMember.
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▼ To Create and Publish an OrganizationObject
An Organization object provides information about an organization. It may have a parent, and
may have one or more child organizations. It always has a User object as a primary contact, and
may offer services by creating associations between the organization and one or more Service
objects.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
Organization.

(Optional) Type values in the PostalAddresses fields.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.
See the following sections for details on adding composed objects to an Organization object:

■ “Adding a Postal Address to an Organization or User” on page 53
■ “Adding a Telephone Number to an Organization or User” on page 54
■ “Adding an Email Address to an Organization or User” on page 55
■ “Adding a User to an Organization” on page 55
■ “Adding a Child Organization to an Organization” on page 56

To add a Service to an Organization, follow the steps in “Creating Relationships Between
Objects”on page 61. The specific steps are as follows:

a. Search for the organization, select its Pick checkbox, and click Bookmark.

b. Search for the service, select its Pick checkbox, and click Relate.

c. In the Create Relationship area, select the organization as the source object. The service
becomes the target object.

d. Set the AssociationType to OffersService.

▼ To Create and Publish a Personor UserObject
A Person or User object provides information about persons and registered users within the
registry. Both kinds of objects have identical attributes. A User object is affiliated with an
Organization object as the primary contact. User objects are also used in AuditableEvent

objects to identify the requestor that sent the request that generated the AuditableEvent.

The recommended way to create User objects is through the User Registration Wizard. Use the
Web Console to create Person objects whenever you want to create metadata about persons
who will not themselves be accessing the registry.
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If you want to be able to create more than one postal address, email address, or telephone
number for the person, create a User object. The Web Console allows you to add postal
addresses, email addresses, and telephone numbers as composed objects for a User object, but
not for a Person object.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
Person or User.

Type values in the Person Name fields.
Specify a value for at least one of these fields.

Do not use the Name field. The Web Console ignores any value you type in the Name field for a
Person or User object.

Add composed objects as described in the following sections:

■ “Adding a Postal Address to an Organization or User” on page 53
■ “Adding a Telephone Number to an Organization or User” on page 54
■ “Adding an Email Address to an Organization or User” on page 55

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

▼ To Create and Publish a RegistryObject
A Registry object represents a registry. Its only attributes are the basic RegistryObject
attributes. You must be an administrator in order to create a Registry object.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
Registry.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

See “To Create and Publish a Federation Object” on page 47 for information on how to add the
registry to a federation.

▼ To Create and Publish a RegistryPackageObject
A RegistryPackage object represents a logical grouping of any number of registry objects.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
RegistryPackage.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.
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To add objects to the package, follow the instructions in “Adding Objects to a Registry Package”
on page 58.

▼ To Create and Publish a ServiceObject
A Service object provides information on a service. It may contain one or more
ServiceBinding objects, which represent technical information on how to access the service.

The most common way to publish a Service object is to publish an ExtrinsicObject object
whose content consists of one or more WSDL files. For more information, see “To Create and
Publish an ExtrinsicObject Object” on page 45.

Execute Steps 1–6 in “To Create and Publish a New Registry Object”on page 42. In Step 2, select
Service.

Execute Steps 8–10 in “To Create and Publish a New Registry Object”on page 42.

To add ServiceBinding objects to the service, follow the instructions in “Adding a Service
Binding to a Service”on page 56.

To add SpecificationLink objects to a ServiceBinding, follow the instructions in “Adding a
Specification Link to a Service Binding”on page 57.

Adding a Classification to an Object
To create a classification, you use an internal classification scheme. An internal classification
scheme contains a set of concepts whose values are known to the Registry.

▼ To Add a Classification
To add a Classification to an object, search for the appropriate classification scheme, then
choose a concept within that classification scheme.

In the Details area for the object, click the Classifications button.
The Classifications table, which can be empty, appears.

Click Add.
A Details Panel window opens.

Type a name and, optionally, a description for the classification.
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Click the Select Classification Scheme or Concept button.
A Classification Scheme/Node Selector window opens.

Expand the ClassificationSchemes node. Then expand concept nodes until you have selected
the leaf node that you want to use.

Click OK to close the Classification Scheme/Node Selector window.
The classification scheme, concept, and value appear in the Details Panel window.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding an External Identifier to an Object
To create an external identifier, you use an external classification scheme. An external
classification scheme has values that are not known to the Registry because the classification
scheme has no concepts.

▼ To Add an External Identifier
To add an external identifier to an object, search for the appropriate classification scheme, then
specify a value.

In the Details area for the object, click the External Identifiers tab.
The External Identifiers table, which can be empty, appears.

Click Add.
A Details Panel window opens.

Type a name and, optionally, a description for the external identifier.

Click the Select ClassificationScheme button.
A ClassificationScheme/Concept Selector window opens.

Expand the ClassificationSchemes node, then select a classification scheme that has no
concepts.

Click OK to close the ClassificationScheme/Concept Selector window.
The classification scheme appears in the Details Panel window.
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Type a value in the Value field.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding an External Link to an Object
An external link allows you to associate a URI with a registry object.

▼ To Add an External Link
In the Details area for the object, click the External Links tab.

The External Links table, which can be empty, appears.

Click Add.

A Details Panel window opens.

Type a name for the external link.

Type the URL for the external link in the External URI field.

(Optional) Click the Select Concept for Object Type button if you want to specify the type of
content to which the URL points.

Expand the ClassificationSchemes node. Locate the content type by expanding the ObjectType,
RegistryObject, and ExtrinsicObject nodes. Select the concept, then click OK. If you do not find
a suitable type, click Cancel. You can create a new concept for ExtrinsicObjects if you want.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding Custom Information to an Object Using Slots
A slot contains extra information that would otherwise not be stored in the Registry. Slots
provide a way to add arbitrary attributes to objects.
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▼ To Add a Slot
In the Details area for the object, click the Slots tab.
The Slots table, which can be empty, appears.

Click Add.
A Details Panel window opens.

Type a name for the Slot.
The name is ordinarily a human-friendly URN.

(Optional) Type a value in the Slot Type field. You can use this field to specify a data type for the
slot or to provide a way to group slots together.
The type is ordinarily the unique identifier value of a concept in the DataType classification
scheme.

Type a value in the Values field.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding a Postal Address to an Organizationor User
An Organization or User object can have one or more postal addresses.

▼ To Add a Postal Address
In the Details area for the Organization or User, click the Postal Addresses tab.
The Postal Addresses table, which can be empty, appears.

Click Add.
A Details Panel window opens.

Type values in the fields. All fields are optional.

■ Street Number
■ Street
■ City
■ State or Province
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■ Country
■ Postal Code

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding a Telephone Number to an Organizationor User
An Organization or User object can have one or more telephone numbers.

▼ To Add a Telephone Number
In the Details area for the Organization or User, click the Telephone Numbers tab.

The Telephone Numbers table, which can be empty, appears.

Click Add.

A Details Panel window opens.

Select a value from the Type combo box.

The following values are available:

■ Beeper
■ FAX
■ Home Phone
■ Mobile Phone
■ Office Phone

Type values in the fields. All fields are optional.

■ Country Code
■ Area Code
■ Phone Number
■ Extension

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.
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Adding an Email Address to an Organizationor User
An Organization or User object can have one or more email addresses.

▼ To Add an Email Address
In the Details area for the Organization or User, click the Email Addresses tab.
The Email Addresses table, which can be empty, appears.

Click Add.
A Details Panel window opens.

Select a value from the Type combo box: Home Email or Office Email.

Type a value in the Email Address field.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding a User to an Organization

An Organization object can have one or more users. One user is the primary contact, which is
normally the user that created the organization. You can create and add additional users.

▼ To Add a User
In the Details area for the Organization, click the Users tab.
The Users table appears.

Click Add.
A Details Panel window opens.

(Optional) Type a description of the user in the Description field.

In the First Name, Middle Name, and Last Name fields, type the first name, middle name, and
surname of the user. Specify at least one of these fields.
Use these fields instead of the Name field. The Web Console ignores any value you type in the
Name field for a Person or User object.
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Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding a Child Organization to an Organization

An Organization can have one or more child organizations. To add a child organization to an
Organization, follow these steps:

▼ To Add a Child Organization
In the Details area for the Organization, click the Organizations tab.
The Organizations table appears.

Click Add.
A Details Panel window opens.

In the Name field, type a name for the new organization.

(Optional) Type a description in the Description field.

(Optional) Type values in the address fields.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding a Service Binding to a Service
A Service normally has one or more service bindings.

▼ To Add a Service Binding
In the Details area for the Service, click the Service Bindings tab.
The Service Bindings table appears.

Click Add.
A Details Panel window opens.
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In the Name field, type a name for the service binding.

(Optional) Type a description of the service binding in the Description field.

In the Access URL field, type the URL for the service binding.

(Optional) In the Target Binding field, type the unique identifier of another ServiceBinding
object to which this service binding refers.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding a Specification Link to a Service Binding
A ServiceBinding object can have a SpecificationLink object.

▼ To Add a Specification Link
In the Details area for the ServiceBinding, click the Specification Links tab.
The Specification Links table appears.

Click Add.
A Details Panel window opens.

In the Name field, type a name for the SpecificationLink.

(Optional) Type a description of the SpecificationLink in the Description field.

(Optional) In the Usage Description field, type a usage description for the usage parameters, if
the SpecificationLink has usage parameters.

(Optional) In the Usage Parameters field, type the usage parameters, if the SpecificationLink
has usage parameters.

In the Specification Object field, type the Unique Identifier of the ExtrinsicObject or
ExternalLink object that represents the technical specification for the parent ServiceBinding
(for example, a WSDL document).

Click Save to save the new object and close the Details Panel window.
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Click Apply in the Details area for the object.

Adding a Child Concept to a Classification Scheme or Concept
A ClassificationScheme normally has numerous child concepts, which can also have child
concepts.

▼ To Add a Child Concept
In the Details area for the ClassificationScheme, click the Concepts tab.
The Concepts table appears.

Click Add.
A Details Panel window opens.

In the Name field, type a name for the concept.

(Optional) Type a description of the concept in the Description field.

In the Value field, type a value for the concept.

Click Save to save the new object and close the Details Panel window.

Click Apply in the Details area for the object.

Adding Objects to a Registry Package
A RegistryPackage is an object that contains other registry objects. Typically, you use a
RegistryPackage to group logically related objects. The objects can be of different types and
can have different owners.

You add objects to a RegistryPackage by specifying their unique identifiers. If you try to type
the unique identifiers, you are likely to make errors. Therefore, the following steps describe how
to add objects by copying and pasting the identifiers.

▼ To Add Objects to a Registry Package
Create a RegistryPackage object as described in “To Create and Publish a New Registry Object”
on page 42. Specify a name and, optionally, a description, but do not add any objects to the
RegistryPackage at this time.
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After you click Apply to save the RegistryPackage, bookmark the RegistryPackage as
described in “To Use the Bookmark Feature”on page 35.

Use the Web Console to search for the objects you want to add to the RegistryPackage.
Bookmark each object as you find it.

Click the Details link for an object you want to add to the RegistryPackage.

In the Details panel for the object, copy the Unique Identifier by using your keyboard (Control-C
or the Copy key).

In the Search Results area, click the Details link for the RegistryPackage.

In the Details area for the object, click the Members tab.

Click Add to Package.

In the Unique Identifier field, use your keyboard to paste the identifier you copied (Control-V or
the Paste key).

Click Add.
The object appears in the Registry Objects area.

Click Apply in the Details area to save the RegistryPackage.

Repeat steps 4 through 11 to add each additional object to the RegistryPackage.

Changing the Status of Objects
In addition to publishing, editing, and removing objects, you can perform the following actions
on them if you are the owner or are otherwise authorized to do so:

■ Approval
■ Deprecation
■ Undeprecation

These features are useful in a production environment if you want to establish a version control
policy for registry objects. For example, you can approve a version of an object for general use,
and you can deprecate an obsolete version before you remove it. If you change your mind after
deprecating an object, you can undeprecate it.

The default status of a created object is Submitted.

You perform all these actions in the Search Results area or in the Details area for an object.
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■ To approve an object, select the object and click the Approve button. A message that
confirms the approval appears. The event is added to the Audit Trail.
An alternative way to approve an object is to select Approved from the Set or Change Status
combo box and then click the Set or Change Status button.

■ To deprecate an object, select the object and click the Deprecate button. A message that
confirms the deprecation appears. The event is added to the Audit Trail.
An alternative way to deprecate an object is to select Deprecated from the Set or Change
Status combo box and then click the Set or Change Status button.

■ To undeprecate an object, select the object and click the Undeprecate button. A message
verifying the undeprecation appears. The event is added to the Audit Trail.
An alternative way to undeprecate an object is to select Submitted from the Set or Change
Status combo box and then click the Set or Change Status button. This returns the object to
its default state of Submitted.

Note – The Withdrawn status is set automatically on an ExtrinsicObject object when you
remove its repository item. Do not set this status manually.

Removing Objects
To remove an object that you own from the Registry, select the object in the Search Results area
and click the Delete button.

Note – Do not delete the User object that was created for you when you performed user
registration. If you delete this object, you can no longer perform any actions on objects that you
published as that user, and you must perform user registration again in order to publish more
objects.

Do not delete AuditableEvent objects for objects that you own. If you delete an
AuditableEvent object, the audit trail for the object that it belongs to becomes corrupted.
(AuditableEvent objects for objects that you own do not appear in the Search Results area if
you do a FindAllMyObjects search, but they do appear if you perform a Basic Query for
AuditableEvent objects.)

If the object is an extrinsic object, you have two choices:

■ Choose Delete Object and Repository Item (the default) from the Deletion Options combo
box to delete both the ExtrinsicObject registry object and the repository item to which it
refers.

■ Choose Delete Repository Item Only to delete the repository item and leave the
ExtrinsicObject in the Registry. You can then add another repository item.

Removing Objects
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The Deletion Options combo box is meaningful only for extrinsic objects.

Creating Relationships Between Objects
Objects can have two kinds of relationship: references and associations. Both kinds of
relationship are unidirectional. That is, each relationship has a source object and a target object.

The Registry supports references, which are called ObjectRefs, between certain types of objects.
For example, if you create a Service and a ServiceBinding, you can create a ServiceBinding
reference from the Service to the ServiceBinding. However, you cannot create a reference
from the ServiceBinding to the Service. A reference is not a registry object.

An Association is a registry object. You can create an Association from any registry object to
any other. The Registry supports an AssociationType classification scheme that includes a
number of predefined association types: OffersService, RelatedTo, HasMember, and so on.
You can also create new association types. If you own both objects in the Association, the
Association is an intramural association. If you do not own both objects, the Association is
an extramural association. If you create an Organization and add a Service to it, an
Association of type OffersService is automatically created from the Organization to the
Service.

If no valid reference exists for the source and target objects, you cannot create a reference.

You use the Relate button in the Registry Objects area to relate two objects. This button
becomes active when you select two objects in the search results table.

If the two objects are not both visible in the search results table, select the Pick checkbox to
bookmark an object while you find the object to which you want to relate it. For details, see “To
Use the Bookmark Feature” on page 35.

▼ To Create a Reference
In the Registry Objects area, select two objects and click Relate.

In the Create Relationship area, select the source object if it is not already selected.
The other object becomes the target object.

If a valid reference exists for the source and target objects, the Reference option is selected by
default, and the valid reference attribute appears. If no valid reference exists for the source and
target objects, the Reference radio button is grayed out.

Click Save to save the Reference.
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▼ To Create an Association

In the Registry Objects area, select two objects and click Relate.

In the Create Relationship area, select the source object if it is not already selected.
The other object becomes the target object.

Select the Association radio button, if it is not already selected.

Type a name and, optionally, a description for the Association in the Details area.
The source and target object ID values are already filled in.

Choose a type value from the Association Type combo box.

Click Apply to save the Association.
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Troubleshooting

This chapter describes solutions to some problems that you can encounter when using the Web
Console.

■ “Unable to Access Service Registry” on page 63
■ “Preferred Locale Is Not Used” on page 64
■ “Search Panel Labels Do Not Appear in Current Locale” on page 64
■ “Unable to Create ExternalLink or ServiceBinding” on page 64
■ “Web Console Error Messages Are Not Clear” on page 64
■ “New Registry Object Cannot Be Saved” on page 65
■ “Web Console Is Unresponsive” on page 65
■ “Login Error from Mistake in Client Certificate Selection” on page 65
■ “Missing Content Error When Publishing WSDL File” on page 66

See “Known Issues and Bugs” in Service Registry 3.1 Release Notes for details about other
problems you might encounter, along with workarounds.

Unable to Access Service Registry
If you receive either an Error 404 or a “Connection refused” message when you try to use the
Web Console, it is likely either that the Registry is not running or that you specified an incorrect
URL.

Make sure that you specify http://hostname:6480/soar/. You might need to specify the
domain in addition to the hostname: hostname.domain.

To make sure that the Registry is running, use the command-line or web interface to the
Application Server domain for the Registry. For details, see “Administering the Application
Server Domain for Service Registry” in Service Registry 3.1 Administration Guide.
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Preferred Locale Is Not Used
If the Web Console is not using your preferred locale, check your web browser preference
settings. Make sure the preferred locale is at the top of the list of locales. See “Changing the
Default Language” on page 14 for details.

Search Panel Labels Do Not Appear in Current Locale
If the Search Panel labels do not appear in the current locale after you change the locale and
click Reset Locale, click End Session, then Return to Registry. See “Changing the Default
Language” on page 14 for information on changing the locale.

Unable to Create ExternalLinkor ServiceBinding
You might get an error in one of the following situations:

■ When you specify an External URI for an ExternalLink object
■ When you specify an Access URI for a ServiceBinding object

The error message looks like this:

The URL: uri is not resolvable.

Use Absolute Path Format [scheme:][//authority][path][?query][#fragment]

This error means that the administrative task described in “Configuring the Java Virtual
Machine (JVM) for the Registry Domain” in Service Registry 3.1 Administration Guide has not
been performed. The Service Registry administrator for your site needs to perform this task and
restart the Registry before you can create these objects.

Web Console Error Messages Are Not Clear
For clarification of the problem that is causing a Web Console error message, examine the
server log for the Application Server domain for the registry. For details, see “Administering the
Application Server Domain for Service Registry” in Service Registry 3.1 Administration Guide.
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New Registry Object Cannot Be Saved
If you get an error message when you try to save a new object in the Registry:

■ If you are using a Registry-generated certificate, make sure that you imported the certificate
into your browser.

■ If you are using a third-party certificate, make sure your administrator placed the Certificate
Authority root certificate in the truststore of the Application Server domain for the Registry.
For details, see “To Add Root Certificates to the Trusted Certificates in the Registry
Domain” in Service Registry 3.1 Administration Guide.

Web Console Is Unresponsive
If the Web Console becomes unresponsive, perform the following steps:

1. Make a note of the error messages that appear.

2. Clear the session cookie in your browser. To clear the cookie, find the cookie with the name
JSESSIONID at the site where the Registry is running and remove it. If you are unsure, delete
all cookies.

3. Restart the Web Console as described in “Starting the Web Console” on page 13.

4. Contact Registry Support and inform them of the error messages and of the steps that led to
the error.

Login Error from Mistake in Client Certificate Selection
If you have more than one client certificate loaded into your web browser, and you choose the
wrong one when you try to log in to Service Registry, the login attempt fails. To correct this
problem, clear your security session by following the instructions for your web browser.

Follow these steps for the supported version of Firefox:

1. Choose Tools→Options→Advanced→Certificates.

2. In the Certificates dialog, under Client Certificate Selection, select Ask Every Time.

3. Also in the Certificates dialog, click Manage Security Devices.

4. In the Device Manager dialog, select Software Security Device and click Log Out.

5. Click OK in the Device Manager dialog.

6. Click OK in the Options dialog.
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Follow these steps for Mozilla and for older versions of Firefox:

1. Choose Edit→Preferences→Privacy & Security→Certificates.
2. In the Certificates dialog, under Client Certificate Selection, select Ask Every Time.
3. Click Manage Security Devices.
4. In the Device Manager dialog, select Software Security Device and click Log Out.
5. Click OK in the Device Manager dialog.
6. Click OK in the Preferences dialog.

If the problem occurs in Internet Explorer, consult the Internet Explorer documentation.

Missing Content Error When Publishing WSDL File
You may see the following error message when you publish a WSDL file:

The following required content is missing from the submission: <filename>. Add this file to your
zip file, and resubmit the request.

This error means that the Registry cannot find a file that your WSDL file depends on. You must
submit a zip file that contains all the files (WSDL files, XSD files, and so on) that the WSDL file
depends on. See “To Create and Publish an ExtrinsicObject Object” on page 45 for details.
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